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Description 
The class will start by demonstrating the use of Spice in EAGLE software to predict the 
performance of the circuit, analyze the results of the Spice simulation and discover how the 
design will dissipate its power thermally. After verifying thermal simulation results, we will 
leverage the design iteration process via A360 collaboration to modify the design. In a real-
world scenario, engineers and designers do not always get it “right” the first time. It takes 
multiple backs and forths between the designer and the engineer to determine a design that 
works and is efficient, yet meets all specifications. We’ll demonstrate this process between 
EAGLE and Fusion 360 software’s capabilities, showing the class how a normal workflow in the 
industry would operate using EAGLE and Fusion 360, smoothly and seamlessly. 
 
  

Learning Objectives 
• Understand and perform the benefits of simulation in the electronics space 
• Learn about the iteration process between EAGLE and Fusion 360 

Simulation environment 
• Learn how to make design choices based on the simulation results 
• Understand and learn how to use the collaborative nature of A360 
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Speakers 
 
 
James Youmatz is a Technical Support Specialist at Autodesk supporting 
Fusion 360 with a focus on Simulation. As an apprentice in the art of CAD 
under Blackbelt CADfu Master, Nathan Chandler in mid 2015, I’ve trained 
diligently. Now as Fusion 360 is growing internationally, I am helping to 
train new CADfu support folks! Always feel free to reach out and say hi! 
 
 
 
 

 
 
 

Edwin Robledo graduated as an Electronic Engineer the 
Polytech University of Puerto Rico. Currently, he is a Global 
Support Manager for the Autodesk EAGLE support Team. His 
career began primarily working in the communications industry 
before joining the EAGLE team 25 years ago. His passion for 
support has lead him to publish best practices articles, Blogs 
and hundreds of video tutorials. His favorite are live Online 
Workshops or onsite boot camps demonstrations. If he is not 
working on electronics, he is usually mountain biking trails in 
South Florida. 
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To take full advantage of the Fusion 360/EAGLE integration options, there are some tools and 
workflow processes to be aware of. This class will present the specifics of the Fusion 360 PCB 
workspace and the Fusion Sync tool in EAGLE, the key workflows used during 
ECAD/Simulation results in Fusion 360/EAGLE, and describe some best practices for designing 
with multidisciplinary teams with these tools.  
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Iterating Between EAGLE and Fusion 360’s Simulation Environment 
 
As many products today require both electrical and mechanical components, it is important for 
electrical and mechanical designers to be able to work together from the start to finish of the 
design process. These design teams must be able to: 
 

• Work together to create a design that meets both the electrical and mechanical 
requirements of the product, including analyzing simulation results as a way to save 
physical cost. 

• Be confident that they are working with the most recent version of the electrical and 
mechanical designs, 

• Quickly respond to design changes implemented by other teams. 
 
The new PCB workspace in Fusion 360 allows for PCB board files from Autodesk EAGLE to be 
integrated into a mechanical Fusion 360 designs. This integration strives to provide 
multidisciplinary design teams with the tools to meet the requirements above.    
 
With these new cross-product tools, designers can create and maintain a link between an 
EAGLE board file and a mechanical assembly design created in Fusion 360. This allows 
multidisciplinary teams to: 
 

• Drive mechanical designs in Fusion 360 off of PCB requirements from EAGLE. 
• Simulate these thermal specifications 
• Make subsequent changes in EAGLE if necessary and push the updated board back to 

Fusion 360 to rerun the simulation 
 
The workflows made possible by the PCB workspace in Fusion 360 and the Fusion Sync button 
in EAGLE allow one file to be used through the entire design process – no more endless file 
conversions to maintain up-to-date board files!  
 
The shape and size of a PCB can often be limited by mechanical components. Before the 
Fusion 360/EAGLE integration, an update to the board would require; 
 

1. A new 3D package of the board design to be output from EAGLE. 
2. That 3D package to be uploaded to a mechanical CAD program. 
3. The existing mechanical components to be edited to meet the requirements of the new 

board design from EAGLE.  
4. The new mechanical components would potentially need to simplified and set up again 

in the Simulation environment 
 
This process occurs in endless iterations until the PCB and mechanical design are finalized! 
With the integration between Fusion 360 and EAGLE, changes to the board can now be 
performed in either EAGLE or Fusion 36. The PCB component can be easily updated in both 
the mechanical and electrical designs. This workflow offers true ECAD/MCAD synchronization 
in which changes can flow back and forth, which gives multidisciplinary teams more freedom 
and propels teams quickly through iterations to a final design. 
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ENABLING THE PCB INTEGRATION FEATURES IN FUSION 360/EAGLE 
Activating the PCB Preview in Fusion 360 
 
The EAGLE/Fusion 360 integration tools are only offered as preview functionality at this time. 
Previews refer to tools within Fusion that are still undergoing early development, but are 
available in Fusion 360 for you to try.  

You can learn more about previews in Fusion 360 at this link. 

To access the PCB workspace in Fusion 360, start by activating the PCB Preview in your 
Fusion 360 preferences: 

 
1. Click on your name in the upper right-hand corner and select “Preferences” from the 

drop-down menu. 
2. Enter the Preview tab of the Preferences dialogue. 
3. Enable the flag for the PCB Feature preview. 

 
After enabling the PCB Feature preview in Fusion 360, we can now 
access the PCB workspace through the Create > Create PCB 
option in Fusion. 

In EAGLE, you must be using version 8.3.0 or newer to access the 
Fusion Sync button to push and pull designs to and from Fusion 
360. 

There are two ways to create a PCB component in Fusion that can 
be linked to a board in EAGLE. Depending on your workflow and 
the design requirements, you can choose from either of the options 
below; 

• Create a PCB component in Fusion 360 and import it into EAGLE, 
• Create a new Fusion 360 design with a PCB component imported from a board 

designed in EAGLE. 
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THE PCB WORKSPACE IN FUSION 360 AND THE FUSION SYNC BUTTON 
IN EAGLE 
 
The PCB workspace in Fusion 360 and the Fusion Sync button in EAGLE are the tools that 
make it possible to edit PCBs in Fusion 360 and push/pull PCB designs between EAGLE and 
Fusion 360. Using the PCB workspace in Fusion, mechanical designers can create board 
profiles, move PCB components, and check the status of both the Fusion 360 and EAGLE 
board components. And with the Fusion Sync button in EAGLE, electrical designers can push 
and pull design iterations of the board back and forth between the two programs. 

The PCB workspace in Fusion 360 
 

The PCB workspace in Fusion 360 is accessible once the PCB preview is activated. To create a 
PCB component in a Fusion design, use the “Create PCB” command in the “Create” drop down 
menu of the Model workspace: 

 
This will bring Fusion 360 into the PCB workspace. The ribbon below will be shown: 
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Once a PCB component has been created in a Fusion 360 design, the PCB workspace can be 
accessed by either double-clicking or right-clicking the PCB icon in the timeline (image below) 
and selecting “Edit.” 

 
 

The PCB workspace includes five new tools; PCB Profile, Copy EAGLE Profile, Move PCB 
Components, PCB Status, and FINISH PCB. These tools are explained below: 

• PCB Profile: This option allows you to define a closed Fusion sketch profile as a 
PCB outline/profile, define the top and bottom of the board, set the board origin 
point and axes, and create a board component in your Fusion 360 design. This 
creates a Fusion Board Shape within the Fusion design file. The PCB Profile 
dialog box is shown below: 

 

 
 

• Copy EAGLE Profile: This option is only available after a board design has been 
pushed/pulled between EAGLE and Fusion 360. It will allow you to copy the 
sketched profile of the current EAGLE version of the board that has been pushed 
or pulled between EAGLE and Fusion. You may select a sketch into which the 
profile sketch will be copied and decide whether or not the sketch will be fixed   

        and/or construction lines as shown below: 
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The Copy EAGLE Profile tool is useful for when a design is pushed into a Fusion 360 
design in which a board profile has not been defined. To define a Fusion 360 board 
profile, a sketch must be present before the PCB component in the design timeline, as 
editing the board will roll the timeline back to when the PCB component was created.  
 
Therefore, as sketch of the board profile earlier in the timelines is required to define a 
Fusion board profile and edit the shape and size of the board in Fusion. This becomes 
difficult because rolling back the timeline to before the PCB component was inserted 
hides the PCB – it is not present in the model at that point in the design timeline. This 
makes it problematic to sketch the Fusion board profile in the correct location on the 
correct plane. The Copy EAGLE profile tool allows us to copy the EAGLE sketch into a 
sketch before the PCB component is inserted and use that sketch for reference when 
creating a Fusion board profile. Fusion vs. EAGLE board profiles will be explained later 
in more detail. The Copy EAGLE Profile tool makes it easier to create a Fusion Board 
Shape in a design that only contains an EAGLE Board Shape. 
 

• Move PCB Components: This option allows you to move PCB components on a 
board that has been had 3D models linked to it through a library component in 
EAGLE after the board has been pushed back to Fusion. Simply select the circuit 
component that you would like to move and use either the manipulator handle or 
numerical entry fields to move it translationally or angularly on the XY     

             plane of the board top. 
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• PCB Status: This tool allows you to check if the Fusion PCB 
component has been altered since the last push from EAGLE to 
Fusion 360.  

 
The three status lines (Board Shape, Board Height, and PCB Components) will show if the 
shape, height, and position of PCB components on the board have changed between the 
last push from EAGLE and the current PCB state in Fusion 360. When both systems are 
synced up, the two board shapes (Fusion and EAGLE) included in the Fusion design are the 
same. 

When the EAGLE and Fusion board shapes are different, there is a danger of an 
inconsistency between the electrical and mechanical designs. The PCB Status tool can help 
manage these inconsistencies. 

In the PCB Status tool, we see the option to activate either the Fusion or EAGLE board 
shape. The Fusion board shape refers to the PCB profile as defined by a Fusion sketch, and 
the EAGLE board profile refers to the profile that was last pushed to Fusion from EAGLE.  

The shape choice radio buttons (Fusion Board Shape and EAGLE Board Shape) can be 
used to select if the EAGLE or Fusion board shape will be shown in Fusion 360. If the 
currently used shape is the EAGLE shape, the board shape will always show as 
"Unchanged," as the shape being used will be the last pushed shape. Selecting the Fusion 
board shape will show if the current PCB component in Fusion has been changed or 
unchanged since the last push from EAGLE. 

A note on this is that the board shape selected in the PCB Status tool will also be the board 
shape used during the next pull of the Fusion PCB component to EAGLE. This is important 
to consider when the shape of the board is edited in Fusion after a push from EAGLE as, if 
the EAGLE board is selected, the changes to the board shape will not be included in that 
exchange. Because Fusion only keeps one copy of the PCB components, changes to the 
circuit components or PCB layout are always made on both board shapes and will always 
be included in a pull to EAGLE. 

If the Fusion board shape is selected and shows that it has been "Changed" since the last 
push from EAGLE and the model is saved, you will have the option to pull the new Fusion 
board shape into EAGLE. 

The Board Height and PCB Components fields are reset each time the board is pushed from 
EAGLE to Fusion 360. Any changes made to the board height or position of the PCB 
components since the last push from EAGLE will be shown when the Fusion Board Shape 
radio button is selected. Please note – changes made in 
the EAGLE board file after the most recent push to 
Fusion will not be shown in the PCB Status tool.  

In the screenshot to the right, the EAGLE Board Shape is 
selected. This means that the EAGLE board shape will be 
shown in the Fusion 360 design and that, since the last 
time it was pushed to Fusion, no changes have been 
made to the Board Height or the PCB Components within 
Fusion. The EAGLE board shape cannot be changed in 
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Fusion (only the Fusion board shape can be), so the EAGLE board shape will always so as 
“Unchanged.” Changes to the board file in EAGLE since the last push will not be shown 
here, so the electrical designer must be sure that the “push to Fusion” button shows no 
changes in the Fusion Sync button of EAGLE. This also means that the EAGLE board 
shape will be used in a pull to EAGLE. 
 

 
In screenshot to the left, the Fusion Board Shape is 
selected. This means that the Fusion board shape will be 
shown in Fusion 360 and that the Fusion board shape has 
been changed in Fusion since the last time the board was 
pushed from EAGLE. It also shows that the board height 
and PCB components have not been edited in Fusion since 
the last push. With this selection, the Fusion board shape 
will be used in a pull to EAGLE. 
 

 

 
•  FINISH PCB: This command allows you to exit the PCB workspace and 
return to the Model workspace of Fusion 360 after creating or editing a 
PCB component is complete, at least for the time being. 
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The Fusion Sync button in EAGLE 
 
The Fusion Sync button in EAGLE allows electrical designers to pull updates to the board 
component Fusion 360 and push changes made in EAGLE back to Fusion 360. This button is 
accessible in the Board window of an EAGLE project. 

 
In an EAGLE board with no link to a Fusion 360 design, you will see the option to create a link 
to the Fusion design or create a new Fusion design. This is shown to the left on the next page. 
 
In a board that is already linked to a Fusion design, you will if the board has been changed in 
either Fusion 360 or EAGLE since the last push to Fusion. This is shown to the right on the next 
page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
When working in EAGLE, you will notice that the color of the Fusion Sync button changes. A 
RED button means that the design you are working with in EAGLE has been altered in Fusion 
360, and a GREEN button means that you have made changes to your PCB in EAGLE that 
need to be pushed to Fusion.  
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The “Push to Fusion” section of the Fusion Sync button is the only place that changes to the 
EAGLE board file will be shown after a board is pushed to Fusion from EAGLE, as the PCB 
Status tool is unable to pull information about EAGLE board file versioning into Fusion 360. 

 

KEY WORFLOWS FOR ECAD/MCAD INTEGRATION IN FUSION 360/EAGLE 
 
There are a few common workflows to be aware of when working with PCB components linked 
between an EAGLE board file and a Fusion 360 design. Step-by-step instructions for the 
worflows listed below are presented in this section. 
 

1. Pushing an EAGLE PCB to Fusion 360 
2. Creating a PCB Component in Fusion and pulling into EAGLE 
3. Creating a new version of a 3D package in an EAGLE library 
4. Simplifying a CAD model before solving a simulation 
5. Setting up and solving a Fusion simulation 

 

Creating a PCB component in Fusion 360 and pulling it into EAGLE 
There are design situations in which the size of mechanical components dictates the allowable 
size and shape of a PCB component. If a mechanical designer knows what size and shape a 
PCB is required to be, they can create a PCB component of the required profile in Fusion 360 
that can be pulled into EAGLE by the electrical team. 
 

1. Create a closed profile sketch in Fusion 360. This sketch can be any shape or size and 
can contain mounting holes or other through features and will define the footprint and 
origin of the PCB component. 
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2. After sketching the PCB profile, 
use the “Create” ribbon menu in 
the Model workspace of Fusion 
360 to access the “Create PCB” 
command.  

 

This will cause Fusion 360 to 
enter the PCB workspace and the 
options below will be shown in 
the ribbon; 

 

 

 

 
 
 
 
 
 
 

3. Use the PCB Profile tool to define the Profile and Origin of the PCB component: 

 
 

a) To define the shape of the board component, select the closed sketch profile 
created in Step #1. You can reverse the direction of the extrusion for the board 



 
 

 

Page 14 

with the “Flip” option and define the sketch as the top of the PCB sketch by 
enabling the “PCB Top” flag. 

 

b) When defining the origin of the PCB component, you can select any point. This 
point will define the origin of the PCB in EAGLE. After you select a point for the 
origin, you may reorient the X and Y axis of the board by enabling the “Reorient” 
flag and then selecting the desired X-axis. The axes shown here will be the axes 
used in EAGLE after the board is pulled. 

 

When setting up the X and Y axes of a PCB component in Fusion 360, the X-axis 
will be previewed in red and the Y-axis will be previewed in green as shown 
above. 

4. Select “OK” to exit the PCB Profile dialogue box and create the PCB. The board will now 
be shown as a solid green body and a Board:1 component will be shown in the browser. 
 

 
5. Use the “Finish PCB” tool in 

the ribbon to exit the PCB 
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workspace and re-enter the modeling workspace. 
 

6. After the PCB is finished, you may need to make 
changes to it. To edit the PCB profile created in the 
previous steps, right-click the PCB component in the 
design timeline and select “Edit.” 
 

7. After saving the Fusion 360 design, the PCB 
component can be pulled into EAGLE. 
 

 

8. Open EAGLE (version 8.3.0 
or higher) and sign into your 
Autodesk Account. 

 
 

9. Ensure EAGLE is connected 
to the internet and you are 
signed into your account 

 
10. Create a new board file 

through the File menu as 
shown to the right. 

 

 

11. Click the Fusion Sync button (a) and select “Link to an Existing Fusion Design,”(b)  then 
“Next” (c). 
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12. Select the source file from Fusion 360 in the Fusion Sync dialogue. Select the desired 
hub first (a), and then navigate through the folders shown to the design containing the 
PCB component (b) that you would like to open in Eagle. Use the arrows to expand 
folders and files to show the PCB components in each file. After selecting the source file, 
hit “OK” (c). 
 

 

 

 

 

 

13. After clicking “OK”, the dialogue to the far left below will be shown. The “pull from 
Fusion” field and the “push to Fusion” field will both be shown as “Out of Sync” because 
the board has not been pulled into EAGLE yet. Click the “pull from Fusion” button to 
begin the pulling process.  
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14. The version description of the Fusion PCB component will be shown (as in the middle 
screenshot above). Select pull to bring the PCB component from Fusion into EAGLE. 
This will show final dialogue shown above (to the far right). 

 

15. After the pull is complete, the Source dialogue will show as “Up to Date” under the “Pull 
from Fusion” heading and the board profile will be shown in the EAGLE board 
workspace. The board can now be edited in EAGLE and pushed back into the original 
Fusion design! 

 
It is recommended to push the board back to Fusion 360 before editing the board in 
Fusion or EAGLE. This completes the integration cycle and syncs the EAGLE and 
Fusion board shapes in the beginning of the design process, as well as guaranteeing 
both a Fusion and EAGLE board shape are present in the Fusion design. 
 

 

Pushing an existing EAGLE board file to a Fusion 360 design 
There are also design situations in which a mechanical design must be built around an existing 
PCB design. In these situations, electrical designers may want to push a board design to the 
mechanical team, who can then work off the existing PCB model to develop mechanical 

Comment [ER1]: Before Editing the board, its best to PUSH 
back to fusion to complete the EAGLE/F360 cycle. After 
everything is synced, then add parts to the board. 
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components. The process to push an existing EAGLE board into a new Fusion 360 is detailed 
below: 
 

1. Open EAGLE version 8.3.0 or higher. 
2. Open an existing board design in EAGLE through the File> Open menu. 

 

3. After the board has opened, click the “Fusion Sync” button (a) and select “Create New 
Fusion Design” (b), then click “Next” (c). 

 

 
 

4. Select the location in your Fusion 360 Data Panel for the new Fusion 360 design that will 
be created when the board is pushed. Select the Fusion 360 hub you are working in (a) 
and the project folder you wish to create the new Fusion 360 design in (b). You can then 
click the “OK” button (c). 
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5. After clicking “OK”, you will see a list of the components on the PCB. If there are any 
problems with the 3D model for any of the components, they will be marked with a 
yellow flag, as shown in the screenshot below. Components with no errors in their 3D 
models will show green checks instead of the yellow flags. 
 

You will also be given the option to add notes in this dialogue. These notes will be 
shown in the version of the file shown in the Fusion 360 Data Panel. After adding any 
notes and checking the 3D packages, click the “push” button to begin pushing the design 
to Fusion. 
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6. After clicking “push”, you will see the message 
shown to the right. You may choose to hide the 
window or leave it open while the board design is 
pushed to Fusion 360. 
 

7. When the push to Fusion 360 is completed 
successfully, you will see the message shown 
below.  

 

 

 

 

 

 

 
 

8. Open Fusion 360 and navigate to the file location the board was pushed to in Step #4 in 
the Data Panel. The new Fusion 360 design created during the push from EAGLE will be 
shown and the comments made during the push will be shown next to the version 
description. 

 

9. The design can now be opened in Fusion 360! When the design is opened, the board 
will be shown as a board component and the electrical components placed on the board 
in EAGLE will be shown as circuit components. 
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You can now begin editing the board in the Fusion 360 file or begin designing a mechanical 
enclosure around the PCB component!  

 

Creating a new version of a 3D package in an EAGLE library 
Another issue that can occur during the electrical design of a PCB is that it can be hard to find 
3D models of certain electrical components to add to a design library in EAGLE. Sometimes a 
model for only one size of a component is available, and sometimes custom electrical 
components need to be created. While Fusion 360 designs cannot be directly linked to 3D 
packages in an EAGLE library, they can be exported in STEP format and uploaded to a new 
version of the EAGLE component.  
 
If an electrical designer has a 2D drawing for a circuit component but not a 3D model, they can 
share that 2D drawing with a mechanical colleague, who can model the required component in 
Fusion 360. The electrical designer could also notice that the model for a circuit component in 
their library is the incorrect size. If this was the case, the electrical designer could share the 
STEP file for the component with the mechanical designer, who could use the modelling tools in 
Fusion 360 to ensure the model is accurate. An example of how to upload a new version of an 
EAGLE library component created in Fusion 360 to the circuits.io library manager is included 
below: 
  

1. Create or edit an existing design for a circuit component in Fusion 360. In this example, 
the height of a potentiometer knob was altered to meet the specifications of a standard 
part by using the “Move Faces” command. 



 
 

 

Page 22 

 
2. Use the (a)File > Export command to save a (b)STEP format copy of the file (c)locally. 

 

 

 

 

 

 

 

 

 

 

 

3. Open EAGLE and open the library containing the part being edited. After opening the 
library, click the “Edit 3D Packages on Web” button. 

 

 

 

 

 

 

 

 

 

4. A web browser will open and navigate to the library editor at circuits.io for the EAGLE 
library. Find the component that is being altered under the “Packages” header and click 
the “Edit” button.  
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5. A new tab will be opened in the web browser and the current 3D model used for that 

library component will be displayed. Click the “Upload STEP” button to import the edited 
STEP file created in step #2. 

 

6. Select the STEP 
file exported from 
Fusion 360 in 
step #2 from the 
location it was 
saved to locally 
and select 
“Open.” The new 
STEP file will be 
uploaded to the 
library and shown 
in the workspace.  

 

7. To save the changes as a new version of 
the circuit package, click the “Draft” button 
and then the “Create a version.” 

 

8. Click the blue circuit 
component button in the 
upper left-hand corner to 
return to the library in the 
web browser. 
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9. Back in the libraries page, select the package you just edited and click the “Update” 
button. The changes you just made will be shown when the update completes.  

 

 

10. Save the updates to the library by clicking the “Draft” button and then the “Create a 
version” button. 

 

 

 

 

 

 

 

 

 

 

 

11. Open the library that was edited in EAGLE. A notification that changes were made to the 
library will be displayed. Select “Update” to update the library. 
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12. The changes made to the 3D package will now be shown when viewing the circuit 
component through its library in the EAGLE control panel and the new 3D package will 
be used when pushing designs using the component and library to Fusion 360. 

 

 
 

Working within EAGLE to Design a Power Supply 
 
EAGLE is a ECAD application that has been around for approximately for 30 years. A program 
by which electronic engineers are empowered to create an electronic schematic and work on 
their circuit boards in real-time. This is accomplished by the means of many components that 
have been made available in the form of libraries categorized by function and manufacturer.  
 

 
 
 
The most recent release of EAGLE now includes a Spice simulation capabilities. 
 
What is Spice Simulation? 
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(Simulation Program with Integrated Circuit Emphasis) 

Circuit simulation programs, of which SPICE and derivatives are the most prominent, take a text 
netlist describing the circuit elements (transistors, resistors, capacitors, etc.) and their 
connections, and translate this description into equations to be solved. The general equations 
produced are nonlinear differential algebraic equations which are solved using implicit 
integration methods, Newton's method and sparse matrix techniques. 
 

Project 
Taking advantage of this recent simulation implementation in EAGLE. We will simulate our 

circuits performance to verify our expected behavior and 
that design goals are met. For this class, we will be working 
on a DC Load Circuit that can be used to verify power 
supply operation.  
This circuit is designed to draw a specified current from a 
connected source. The user will be able to specify that 
current using 2 potentiometers (knobs). One of the pots is 
a course adjustment which get you in the range of the 
specified current. The second knob allows the user to 

precisely tune the current drawn. DC Loads are commonly used in applications such as battery 
characterization where you want to be able to accurately measure the lifespan of a battery and 
how it’s output drops over its useable life. In those scenarios, the DC load draws a constant 
amount of current from the battery and we can just track its voltage drop over time. These 
devices are also used when testing power supplies. Often power supplies are rated to output a 
certain current at a specified voltage for example 10Amps at 12 V. How do we know that the 
supply can indeed provide that current at that voltage? The answer is to use a DC load, we 
connect it to the power supply specify for 10 Amps to be drawn and observe what happens. 
 
Industrial loads can draw 100’s of amps and dissipate thousands of watts of power. Our project 
is far more modest. Our design is made to draw 5 Amps (It can do 5.5 but it’s intended to be 
used to a maximum of 5Amps) and can dissipate a maximum of 20W. What’s makes the design 
of DC loads challenging is that the power being dropped across the transistor must be 
dissipated as heat, it must go somewhere. The industrial loads I mentioned dissipate this power 
using heatsinks, fans, and in rare cases liquid based cooling systems. Simulations can allow 
designers to get a good idea of the heat dissipation requirements of their designs before they go 
into production, avoiding costly redesigns later. 
 
In our class, we will use SPICE simulation to verify that the circuit as designed will draw the 
specified amount of current and that it will perform as expected. This allows us as designers to 
verify our design intuition and the calculations we made at the beginning of our design cycle. 
This simulation will show us that the pass transistor has to dissipate 20W according to our 
design criterion. We will then pass the circuit into Fusion360 to perform thermal studies this will 
allow us to verify some simple hand calculations and guide us in the selection of a heatsink that 
will help our load to be a reliable working tool. 
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The EAGLE SPICE simulation 
 

 
The standard EAGLE circuit is not ready as is to be simulated. There is a lot of digital circuitry in 
this design used for measuring the drawn current and displaying it on an easy to read display. 
The SPICE simulator cannot simulate these components so these have to be removed from the 
simulation schematic. Additionally, there is no load to draw current from in the main circuit so to 
simulate the circuits operation we have to add an Ideal voltage source to supply the current 
drawn. Additionally, the input potentiometers are difficult to simulate so they are replaced with 
an adjustable voltage source that will be swept through the same range that the potentiometers 
can sweep through this will allow us to observe the circuits operation. 
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At this point the circuit topology is ready to be simulated, however we must make sure that all 
the components have SPICE models (This process is detailed in the video series here: 
https://www.youtube.com/playlist?list=PL1rOC5j_Fyi46HXbWw8QFAtEWRJ-hfpBa). EAGLE will 
complain if there are any components missing SPICE models. SPICE models can be obtained 
from component manufacturers who make them available so that customers can verify their 
designs with them. In our case I could find a suitable model for the Op Amp easily, however 
there wasn’t a model available for the MOSFET. Making your own model is a non-trivial 
exercise so it’s usually better to find a similar part that has a model available. For this purpose, I 
used a model of a transistor with similar specs from On Semiconductor(NTMFS5H600NL). 
Once all the models have been assigned the design is ready to be simulated. 
 
To verify the circuits operation, we will perform a DC sweep simulation, which will allow us to 
sweep the input voltage over the useable range of the design and observe how it responds to 
this stimulates. The picture below shows our setup. 
 

 
 
Pressing the Simulate button starts the simulation process and in a few seconds, we are 
greeted with this graph. 
 



 
 

 

Page 29 

 
 
This graph shows two lines but they lie directly on top of each other. As you can clearly see in 
the values at the top right of the dialog, at the peak input voltage the circuit can draw a 
maximum of 5.5 Amps even though its designed for a max draw of 5 Amps. It’s common for 
designs to give some margin to account for component variations and other unknowns. The 
power that the pass transistor must dissipate can be determined by multiplying the load voltage 
by the 5 Amps we want to draw. This brings us to the 20W of power that the transistor needs to 
dissipate. 
 
At this point it would be prudent to review the transistor’s data sheet to get an idea of how hot 
the component will get. 
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If no heatsink is involved we use the junction-ambient value. Without a heatsink the component 
will see a temperature rise of  
 
75 K/W * 20W = 1500 degrees K! 
 
This result comes from a very simplified model but it gives a strong indication that we need a 
heat dissipation mechanism, a thermal simulation will give more realistic results and will also 
confirm that the design requires a heatsink to keep the transistor below its maximum operating 
temperature of 150C. 
 

 
 
As can be seen in the graph above, we chose a heatsink that has a thermal resistance of 3 
K/W. When using a heatsink we use the junction-case value instead of the junction-ambient. 
Because a thermal grease is used to make sure the heatsink and transistor make good contact 
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(and to simplify the calculation) we will round the junction to case value to 1. The temperature 
rise would now be: 
 
1 K/W * 20W + 3 K/W * 20W = 80 degrees K 
 
Much more reasonable, again a thermal simulation study is used to confirm this.  

 

The following paragraphs will move into Fusion 360 and the simulation environment. Before we 
dig into the design scenario we presented above, some theory is needed on thermal simulations 
as well as exploring the simplify environment – necessary to have a successful physics 
simulation.  

 

Simplifying a CAD model in Fusion 360 before solving a simulation 
 
Production geometry can often benefit from defeaturing or simplifying the model. Spending a 
few minutes optimizing your geometry for simulation can pay off dividends in the solving time. 
Also, a simplified model is less prone to meshing problems and easier to troubleshoot when 
errors occur.  
 
A simulation model is typically less detailed than a manufacturing model. There are often 
features in a production design that are unimportant with regard to stress, modal, or thermal 
simulation. However, they can greatly increase the complexity of the mesh (producing a high 
element count). Therefore, the file size and solution time increase. Examples of potentially 
unnecessary features are embossed or raised part numbers and fillets on external corners. 
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Fortunately, Fusion 360 comes equipped with a tool within the Simulation environment called 
the Simplify workspace. Use the tools in the Simplify workspace within Fusion 360 to remove 
bodies or features that are unnecessary for simulation. You can also split faces to confine loads 
or constraints to only a portion of a larger face. Finally, you can make other geometry changes 
to gauge how the simulation results are affected by model variations 
 

Which features can I remove? 
 

• You can remove small holes, notches, or protrusions if all of the following statements are 
true: 

o The feature is well removed from the critical stress region, so stress 
concentration effects are not a concern 

o The feature does not have a significant effect on the overall stiffness of the 
structure 

o The feature is not needed for a constraint or load application edge or face 
o If running a modal frequencies analysis, the feature does not alter the mass 

enough to significantly affect the natural frequencies or mode shapes 
• Typically, remove threaded fasteners (screws and bolts). These items require a complex 

mesh and many contact surfaces to represent adequately. Instead, define Connectors 
between parts of an assembly in place of the threaded fasteners. The exception is when 
a specially designed fastener is the focus of the analysis. 

• Remove lifting eyes or handles unless these parts are the focus of the analysis. 
• Remove parts that are attached to an assembly when they do not contribute to the 

stiffness or integrity of the structure. Examples are name plates, decorative moulding, 
panel switches, or indicator lights. 
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Note: Do not remove fillets on interior corners unless the area is well removed from the critical 
stress regions. Fillet radii are very important in capturing accurate stress concentration effects at 
inside corners (such as shaft neck or shoulder radii). 
 

Using the Simplify Environment 
 
This environment is pretty self-explanatory and offers a few tools that really help speed up the 
simplification process. These tools include Remove Features, Remove Faces, and Replace with 
Primitives – as well as the standard modification tools that come standard with Fusion 360 in the 
modeling environment. Do be mindful however when using this environment that some 
geometry changes can affect simulation results. Since Fusion tries to auto-heal any surface (for 
example deleting a rounded edge causes a hard edge), without checking it – you may run into 
an issue where the geometry has changed drastically from the original intention.  
 

Remove Features 
 
The Remove Features command allows you to remove small features, and it has the flexibility to 
choose the types of small features to remove. By default, all options in the features list are 
checked (that is, selected for removal). Simply deselect any features that you don't want 
removed. 
 
Remove Features is found in the MODIFY panel of the SIMPLIFY toolbar: 

SIMPLIFY  MODIFY   Remove Features 
 
Removal is supported for the following types of features: 

• Fillet 
• Hole 
• Chamfer 
• Extrude 
• Revolve 
• Other: Features that are small in comparison to the selected body that weren't created 

with one of the above commands. 
 

Workflow 
1. Activate the Remove Features command. 
2. Select the body or bodies to remove features from. Selecting multiple complex bodies 

slows the command down. 
3. Optionally, click Manual features and select features that are not highlighted to be 

removed. 
4. Move the slider to the right to select larger features or to the left to unselect features and 

only remove smaller features. 

5. Click the  next to Delete to remove the indicated features. 
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Note: The command remains open and recalculates the automatic feature size for removal. 
 

Remove Faces 
 
Deleting a single face of the original geometry can produce an undesired outcome , or the 
attempt sometimes fails. The Remove Face command automatically selects neighboring faces 
(to be removed with the selected face) so the geometry can be properly healed. For example, if 
a fillet was created on multiple edges, one segment cannot be removed while keeping valid 
geometry. In the picture below, the highlighted face was selected, and the two neighboring 
faces need to be removed as well to properly regenerate the geometry. 
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Follow these steps to use the command: 

1. Activate the  Remove Face command from the MODIFY panel of the SIMPLIFY 
toolbar. 

2. Select a face or faces that you would like to remove. 
3. Click the red "X" next to delete. 

 
Tip: Pay attention to the automatically added faces. It is possible that the automatic selection 
does not get all the intended faces or selects too many faces. Additional faces can be selected 
before deleting. 
 

Replace with Primitives 
 
Replace with Primitives allows you to quickly replace complex geometry with a simple piece of 
geometry (a Box, Cylinder, or Sphere). You can use the command on multiple bodes or 
components to substitute a single shape for the original bodies, which are removed. The size of 
the primitive is initially determined using a bounding shape that surrounds the selected volumes. 
You can modify the size graphically (using the grips) or numerically (using the size parameters 
in the dialog). 
 
Often times, a part may be necessary but is overly complex, and a simple representative shape 
would be sufficient for simulation. In other instances, there are recurring parts or a group of 
bodies or components that could be simplified into a single part. 
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When a part is complex, it is possible to use the Remove Features command, but that 
command requires time for all the calculations to properly heal the part. Replace with 
Primitives can quickly place a simple shape and remove (commonly known as suppress) the 
undesired part without requiring all the calculation time. 
 
Other instances, when a group of parts could all be replaced with a single simple 
shape, Replace with Primitives comes to the rescue. The initial shape created using replace 
with primitives is a bounding simple volume surrounding all the selected bodies or components. 
For example, an LED headlight may have numerous small components making up the 
configuration of the LED's. To run a thermal analysis, all the LEDs could be replaced with a 
single body, and the collective heat load applied to the one body. A more accurate thermal 
profile may be required to show the heat on each LED. Making each LED into a primitive more 
appropriately distributes the heat generation while keeping the element count down. The 
complex geometry of an LED isn't necessary when trying to get a fast look at the system-level 
thermal profile. Either of these methods can be valuable and time-saving when setting up an 
analysis. 
 
 
Workflow: 

1. Activate the  Replace with Primitives command in the MODIFY panel of the 
SIMPLIFY toolbar. 

2. Optionally, change the Object type to Components to make selection easier. 
 

Note: When the object type is set to Bodies, you cannot select bodies from separate 
components. With Components selected, all bodies within a selected component are 
automatically selected. Make sure that the browser setup allows the selection of the desired 
bodies. The Components option also allows you to activate the Replace all 
occurrences option. 
 

3. Select the desired objects to replace with a single simple shape. 
4. Select the Primitive Shape. 

 
Note: Cylinder requires an axis specification that must be inline with one of the primary axes (X, 
Y, or Z). 
 

5. Modify the size using the grip arrows on the shape in the graphics window or by entering 
dimensions in the dialog. 

6. Click OK. 
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Setting up and solving a Fusion Thermal Simulation 
 
Thermal analyses are a steady-state heat transfer analysis used to determine the steady-state 
temperature distribution and heat flow. Design parameters can often involve a maximum critical 
temperature that causes a part failure. If your design is part of a larger design or system it may 
be of interest to understand and control the heat flow. 
 
When performing a thermal analysis on an assembly, it is important that you consider the 
resistance to heat flow that occurs along contact areas. For thermal analyses, an additional 
contact setting appears in the EDIT CONTACT dialog: 
 

 
 

Thermal Conductance  
Use this field to specify the heat flow across the contact interface per unit area per degree. The 
units are fixed at W / (m2·°K). The Watt (W) is a unit of power equivalent to one Joule (J) of 
energy per second. Currently, you cannot choose alternative units for the Thermal Conductance 
of a contact pair. 
 
This input field is blank by default, and infinite thermal conductance is assumed (no resistance 
to heat flow). With no thermal resistance, the temperature results are identical on both contact 
faces. 
 
When you specify a value, the results will show a temperature difference across contact 
boundaries due to the limited thermal conductance. 
 
An electronic component such as a semiconductor, mounted to a heat sink is an example of 
when thermal conductance across contact faces is important. The surface of the semiconductor 
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is hotter than the surface of the heat sink where they meet. The conductance varies depending 
on the heat sink compound applied and whether or not an electrical insulator is installed 
between the parts. The semiconductor temperature will be underestimated if you do not specify 
the appropriate thermal conductance for the contact set. 
 

Thermal Analysis Requirements 
 

 
 

This type of analysis requires: 
• The loads and constraints are independent of time. Steady-state means that the solution 

can be considered after an infinite amount of time has passed. 
• A source and sink of heat must be defined. If there is only a source and no means to 

remove heat, the temperature of the model would be infinite. Conservation of energy 
must be observed, energy in must be equal to energy out. 

• At least one temperature-based thermal load is required to provide a reference 
temperature. A temperature profile can not be calculated across a part with 5 W into one 
side and 5 W out another side. A reference temperature is needed to provide the 
temperature profile. 

•  

Theory and references to help set up a Thermal Simulation 
 
A thermal analysis is calculating the Conduction of energy across the geometry. Conduction 
can be mathematically defined as: 
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Where 

• Q = Heat flow 
• k = Thermal conductivity, which is entered as a constant material property 
• A = Cross-sectional area (calculated by software) 

•  = The change in temperature in the direction normal to the Area 
•  

Conduction is the basis of what is calculated throughout a model. The true power of a thermal 
analysis is properly defining how the world that isn't modeled effects a design. The external 
effects and some internal effects are defined as loads. Thermal Loads can depict other types of 
heat transfer 
 
Convection is the transfer of energy between a fluid and a solid (typically the surrounding air). 
Convection is mathematically defined as: 
 

 
 
Where 

• Q = Heat flow 
• h = Convective heat transfer coefficient (entered manually, and assumed constant) 
• A = Surface area of the selected surface (calculated by software) 
• Ts = Surface temperature of the selected surface (calculated by software) 
• T = Ambient fluid temperature (entered manually, and assumed constant) 
 

To properly account for convection to the world around a model, the convective heat transfer 
coefficient is key. Many factors can affect the coefficient, from velocity of the surrounding fluid to 
what the surrounding fluid is. When we consider that computers often use fans for cooling, to 
increasing the velocity of the fluid is increasing the h value. The higher h value in turn reduces 
the temperature. The physical properties of the fluid also change the coefficient. To keep the 
same frame of reference, some computers use liquid cooling instead of air. The h values from a 
liquid tend to be more efficient (higher) than a gas. 
 
Note: A standard natural convection coefficient to air is in the range of 5-25 W/m^2*k. 
Many examples can be found online for different fluids or conditions. 
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Required Load Entries 
 
Temperature 

• Specify the temperature in the desired units, such as Celsius. 
 

Heat Source 
• Specify the amount of heat in the desired units, such as Watts. 
• Use the Unit Area checkbox to specify heat on a per unit area basis (instead of the total 

heat). The input units are changed accordingly. For example, the input window shows 
W/mm^2 instead of W (or similar unit changes) when you check this box. 

 
Radiation 

• Emissivity/Absortivity Value is a coefficient in the radiation heat transfer equation. The 
coefficient can be specified from 0-1, lower values being more reflective and higher 
values being closer to a black body. 

• Specify the temperature of the surroundings. The heat radiates to or from the specified 
entities. 
 

Convection 
• The Coefficient Value is the film coefficient value from the convection heat transfer 

equation. Typical natural convection values for air would be in the 5-25 W/m^2 range. 
• Specify the temperature of the surrounding fluid (typically air) in the desired units. The 

heat convects to or from the specified entities. 
 

Internal Heat 
• Can be specified as a constant heat load or as a heat load that is temperature 

dependent. 
• Use the Unit Volume checkbox to specify internal heat on a per unit volume basis 

(instead of the total heat). The input units are changed accordingly. For example, the 
input window shows W/mm^3 instead of W (or similar unit changes) when you check this 
box. 

• Specify the amount of heat in the current units. You can select alternative units to 
override the current default. 

• Enter a curve of internal heat versus temperature for temperature dependent loads. This 
type of load can be useful for heaters or other things for which the amount of heat being 
generated or removed depends on the temperature of the device. 
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Thermal Results 
 
The following results are only found in Thermal and Thermal Stress analyses: 
 
Temperature 

• Units are temperature such as °C. 
• Can be used to determine if minimum or maximum values are out of a parts operating 

range or if safety is a concern. 
•  

Heat Flux 
• Units are power per unit area, such as W / m^2. 

 
Can be used to understand the performance of the heat transfer through your part or assembly. 
 
Thermal Gradient 

• Units are temperature per unit distance, such as °C / m. 
• Can be used to understand the rate at which the temperature is rising or dropping across 

your part or assembly. 
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Simulating the Power Supply 
 
Now, with all of the theory presented in what goes into a thermal simulation, it is time to set one 
up in Fusion 360. To do this, enter the Simulation Environment and select Thermal Simulation 
as the simulation study type with the pushed EAGLE model of the board open. 
 
NOTE: At this time you are unable to push/pull a board between EAGLE and Fusion that 
has an active Simulation study. Therefore, using the techniques described in the 
begininning of this hand out to create a New Design and insert the Board design into the 
a blank design meant only for simulation (thus linking the new design to the board). This 
will allow you to maintain the EAGLE/Fusion associativity, and have a simulation study 
present.  
 
After the study type has been selected, the Simplify environment should be used and an 
example of a simplfied board should look as the following: 
 

 
 
Once simplified, it is time to set up the simulation and the boundary conditions on the board. 
Using the knowledge that was presented regarding contacts, constraints, and load types – we 
can easily set this up. 
 
The first step here is to analyze the board without a heat sink. Although we can pretty easily 
assume that the heat source needs a heat sink to successfully dissipate the heat without 
causing part failure – it is worthwhile to set this simulation up and see if this assumption is 
accurate or not. If it is not and a heat sink is not necessary, we can easily cut down the cost and 
size of this board.  
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Next, we define the materials that will be used in the board. In this case it is Aluminum 6061 for 
all of the components on the board and FR4 for the actual board itself. Using the material 
manager, check the thermal properties values for each material to ensure that the values make 
sense – otherwise the results will be incorrect. 
 

 
 
Once all the materials are defined correctly for the model, it is time to add a load to the model. 
In this case there are two loads that we need to concern ourselves with – an internal heat (the 
transistor) as well as convection on all of the surfaces that are exposed to air. 
 

 
 
Focusing on the Heat Source first, we select the Thermal Load button from the Ribbon. We first 
select the transistor as our body for the heat source and for load type, change it to Internal Heat. 
Then we define the internal heat to be 20W which was provided above in the EAGLE simulation 
section. Select OK when done.  
 
Next, we move onto the next load type which is convection. Again, we select the Thermal Load 
button from the Ribbon, but this time change load type to convection. In this model, we are 
going to use two loads of convection, one applied to the board and all of the components, and 
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one that is applied to the open faces of the transistor. The reason we do this is for ease of 
selecting the faces. The board is treated as one body in the model and therefore can easily be 
selected. The same logic applies to the transistor. Although we will be using the same 
convection values, creating two separate loads will allow us to easily edit the model if need be.  
 
NOTE: By using the Select All Faces option, you can quickly apply convection to all the 
faces on the board. 
 

 
 
For this model, we chose ambient air temperature to be 20 degrees Celcius and our heat 
transfer coefficient to be 12 W/m^2 K. Referring back to our section on Convection, we specified 
that any value 5-25 is reasonable, but is dependent on the model geometry and physical 
conditions of the environment. Getting a specific number is challenging and requires air velocity 
and flow design which is not currently doable in Fusion. Assuming 12 allows us to overestimate 
our results a little bit, and design for a higher factor of safety.  
 
Once all the convection values are set, we can use the Pre-Check option in the Solve menu to 
see if we are missing anything in our setup or if there are interferences.  
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NOTE: If there are interferences, go back into the simplify environment and use the 
Combine tool in order to combine multiple geometry bodies into one to eliminate any 
interference.  
 
Once the pre-check is completed, we can go ahead and solve the simulation. Once solved, we 
can see that our results prove our assumption which is that the transistor temperature will well 
exceed the critical temperature which is 150 degrees Celsius. Therefore, we need to design the 
board to include a heat sink and resolve the simulation. 
 
 
 At this time, it is time to communicate back to our electrical engineer using some of the 
communication tools demonstrated below, and then push a new board back with a mapped heat 
sink into Fusion.  
 

Communication tools for ECAD/MCAD integration in Fusion 360/EAGLE 
 
While the EAGLE and Fusion 360 integration tools make it much easier to manage versions of 
both mechanical and electrical design files, it is still important to provide documentation for each 
design iteration, particularly when the PCB component is altered. Fusion 360 provides a variety 
of tools to include comments on both the mechanical and electrical designs. The PCB Status 
and Fusion Sync tools in Fusion 360 and EAGLE have already been discussed, and the 
communication tools always available in Fusion 360 are described below: 
 

• Fusion 360 design versioning and version comments 
Each time a Fusion 360 design is saved manually, a new version is created. Whenever a 
new version is created, Fusion 360 gives the option to include include a comment on 
that specific version. Before a PCB component is pulled from Fusion 360 to EAGLE, the 
board must be saved, which gives mechanical engineers opportunity to provide the 
electrical team with insight into any changes made to the PCB in Fusion 360.  
 
When an electrical engineer pushes a board or board update from EAGLE to Fusion 
360, they are creating a new version of the design and will be given the opportunity to 
provide comments on any changes they made in EAGLE while pushing the board 
update within the “Version Description” field in the Fusion Sync dialogue.  
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If a board design needs to be rolled back to a previous version and a back-up file was 
not saved out of EAGLE, the mechanical team can roll the Fusion 360 design back to a 
previous version (containing the previous version of the PCB design) and the electrical 
team can then pull the board back into EAGLE from the previous Fusion 360 design 
version. 

• Comments within a Fusion 360 
design 

Because both the electrical and 
mechanical teams will have access 
to the mechanical assembly design 
in Fusion 360, both teams can use 
the “Comments” tool within the 
Fusion 360 design to comment on 
the design. Screenshots and 
markups can be included in these 
comments. 

 

Along with these comments, the Fusion 360 and EAGLE integration requires a new version of 
the design to be created with each push or pull and when changes made to the board in Fusion 
are saved, so a new version will be created and available and visible in the Fusion 360 data 
panel even if no comments are made. 

 

Updating the Fusion Simulation with the New Board 
 

At this point a new board has been created within EAGLE and has been pushed live to Fusion. 
Since the board is XREF’d to our simulation model, all that needs to happen is an update to the 
Assembly and all components will update. Since the heat sink caused some board geometry to 
change, it is important to check the Simplify environment again to ensure that the model is still 
simplified and the simplify timeline is free of warnings or errors.  
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Once verified that the updated model is simplified fully, all that is left to do before rerunning the 
simulation is verify that all the initial boundary conditions are set up right. In this case – 
convection needs to be added to the surfaces of the heat sink. That are exposed to the air. In 
this case,  

 

NOTE: Since the heat sink will not have any convection for where the transistor is in 
contact with the heatsink, we need to modify the heat sink in the Simplify menu to split 
the face of the heat sink. To do this, enter the Simplify menu and select Modify->Split-
>Split Face 
 

 
For this, you would use the face of the Heat Sink as the face to split, and the transistor as 
the tool.  
 

Once all boundary conditions are confirmed correct, it is time to solve again and analyze the 
results. In this scenario with only an internal heat, convection acting on all of the open surfaces, 
and an ambient air temperature of 20 degrees Celsius, we want to analyze: 

• Is the transistor close to its critical temperature of 150 deg Celsius 
• What is our factor of safety when analyzing the transistor 
• Does the heat distribution across the entire board make sense 

o For instance, is the further point on the board away from the transistor close (if 
not) ambient temperature and gets warmer as you approach the transistor 

o Does the heat sink appropriately dissipate heat. 
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As we can see in the above photo, the minimum and maximum temperatures make sense for 
what we can expect. Although this is an approximation we can verify our results by comparing 
them to our hand calculations.  

  



 
 

 

Page 49 

The average temperature on the transistor is about 100 degrees Celsius. When using the 
convection equation: 

 
Q=20 W 

h= 12 W/m^2 K 

A (approximation, using heat sink surface area)=0.025 m^2 

T=20 degrees Celsius 

 

We get our average transistor temperature to be about 87 degrees Celsius. Our results of the 
simulation show it is about 102 degrees Celsius, so we are a little bit off from our hand 
calculations but within an allowable range.  

 

Also, when analyze the colors of the image posted above (which shows the temperature 
distribution), we can see an even symmetric flow around and on the heat sink, as well as on the 
transistor and gradually cooling and nearing ambient temperature the further we get away from 
the transistor we get. In this design scenario, we have proven that a heat sink is necessary, and 
the heat sink chosen will meet the design criterion as to not cause, or come too close to, a 
failure point. Other transistors could be theoretically tested very quickly as we proved with just 
the addition of one heat sink to test multiple design scenarios at once and verify which heat sink 
is the most justifiable for the cost.  

 

 

 
 
 
 
 
 
 


